Introduction
This user guide gives you step by step instructions on how to install the CD-ROM drive, (optional) interface card, cables and driver software into your computer. We recommend that you read this user guide completely, paying special attention to the safety notices, before proceeding with the installation. Please keep this user in a safe place for future reference.

Contents
Important safety notices .........................................................2
CD-ROM drive - Quick reference guide ..................................................3
System requirements ........................................................................4
Hardware installation
(Optional) interface card ......................................................................4
Installing the CD-ROM drive ..............................................................6

Software installation
DOS Systems ......................................................................................8
Windows Systems ................................................................................10
OS/2 Systems ....................................................................................13
Windows 95 Systems ...........................................................................14
Windows NT Systems ..........................................................................15
Guide to operation ...............................................................................16
Maintenance and care instructions .........................................................16
Troubleshooting guide .........................................................................17
Glossary ..............................................................................................18
Trademarks and copyrights ....................................................................19

Note: References are made in the following text to “CR 504” (relevant to RS stock numbers 228-6600 and 228-6616).

If you are installing the following stock numbers, 268-1594 and 268-1601, please refer to “CR 508” instead.
Important safety notices

For your safety please read the following instructions carefully:

1. When installing the CD-ROM drive it will be necessary to remove the top cover of your computer.
   To avoid electric shock ensure that your computer is turned off and the AC power is removed from the mains socket before installing this CD-ROM drive, (optional) interface card or any other peripheral equipment.

2. Class 1 laser product
   This equipment complies with European standard EN 60825 (or international Electrotechnical Commission [IEC] Publication 825).
   This equipment is classified as a class 1 LASER product and there is no hazardous LASER radiation with the safety protection specified by EN 60825.
   Caution: Use of controls or adjustment or performance of procedures other than those specified herein may result in hazardous radiation exposure.
   Do not remove the top cover of the equipment and never touch the internal parts in order to avoid exposure to invisible radiation.
   When the power switch is on, do not place your eyes close to the front panel, motorised tray or other openings to look inside the equipment.

Laser specification
Class 1 Laser product
Wave length: 765 - 815nm
Laser power: 0.19mW. No hazardous radiation is emitted with the safety protection specified by EN 60825

3. The labels affixed to the equipment are there to remind you of safety precautions.
   These labels must not be removed.
   The label shown below indicates the position of the laser in the equipment. This label must not be removed.

   CLASS 1 LASER PRODUCT
   According to EN 60825
   APPAREIL A LASER DE CLASSE 1
   per le loi EN 60825
   LASER KLASSE 1!
   nach EN 60825

4. Radio frequency interference
   This equipment has been tested and found to comply with the limits for a Class B device, pursuant to EN 55022 (European Standard of Radio Frequency Emission for Information Technology Equipment).
5. To reduce the risk of fire or shock hazard, do not expose this equipment to rain or water. Do not place containers of liquid on or near this equipment.
6. When listening to audio CDs using headphones, do not turn the volume up too high. Your hearing may be impaired if your ears are exposed to very loud sounds.

Trademarks and copyrights

IBM and OS/2 V3 are trademarks of International Business Machines.
Photo CD™ is a trademark of Eastman Kodak Company.
Microsoft Windows 95 and Microsoft Windows NT are trademarks of Microsoft Corporation.
All other product names or trademarks are property of their respective owners.

Glossary

ASPI Manager The ASPI Manager, usually supplied with your card is a software module that you install in your system. ASPI Managers are developed for specific SCSI interface cards and operating systems and provide a standard software interface for SCSI device drivers.

Device Driver Refers to the software programs for enabling data communication between a personal computer and the SCSI peripherals.

Host adapter The SCSI interface expansion board installed in the computer is often called a “host adapter”.

ISA This is an acronym for “Industry Standard Architecture” and is used to describe the computer bus used in IBM PC AT and compatible computers.

SCSI Each device (including the host adapter on a SCSI bus requires a unique SCSI ID. The SCSI ID is used to address each device attached to the computer.

SCSI interface This is an acronym for “Small Computer System Interface” (pronounced “scuzzy”). It is a standard general purpose interface for connecting peripherals to a computer.

Terminator The SCSI bus requires a terminator on the first and last devices on a SCSI chain to ensure that SCSI signals are transmitted without error.

CorelSCSI (DOS/Windows Version) Ver 2.1

This device driver software is developed by Corel Corporation. CorelSCSI! is a registered trademark and CorelSCSI software is the property of Corel Corporation and are protected by copyright. Any reproduction in whole or in part is strictly prohibited.
MS-DOS and Microsoft are registered trademarks of Microsoft Corporation.
MS Windows is a trademark of Microsoft Corporation. MSCDEX is a copyright of Microsoft Corporation.
All other product names or trademarks are property of their respective owners.
Troubleshooting Guide

Symptom                              Check the following
Tray fails to open                   • Is the power connected?
Tray fails to close                  • Is the CD inserted correctly?
Busy LED fails to light             • Is the CD inserted correctly?
• Is the power connected?
System fails to start up            • Check hard drive and CD-ROM drive jumper settings.
• Check SCSI cable connections (pin 1 to pin 1).
• Is the device driver disk still in the floppy drive?
Device driver fails to load.        • Check above.
CDs or CD-ROMs cannot be read.     • Has the CD been placed correctly on the tray?
• Has the CD been placed with its label side up?
• The CD may be dirty, clean it.
• Is the CD scratched, warped or otherwise damaged?
• Has condensation formed on the disk or inside the drive?
• Are you using the software program for playing CDs or CD-ROMs correctly?
CD-ROM is not installed in Windows  • If Windows is automatically started at boot from the AUTOEXEC.BAT file, make sure that it is started after CORELCDX has been loaded.
No sound or low sound                • Has the audio cable been connected correctly?
level via sound card                • Check the sound card installation according to the manufacturers instructions.
• Has the volume control been set to the correct level?
No sound or low sound                • Only audio-CD sound is output via headphone socket.
level via headphones                • Has the volume control been set to the correct level?
Not enough conventional memory     • Reduce the number of DOS buffers in CONFIG.SYS.
memory after installation           • Reinstall CorelSCSI and load drivers into upper memory (Refer also to your DOS manual).
• Run MEMMAKER (DOS 6.0) or other memory optimisation software.
Choppy playback of large AVI files  • Change the CDXCACHE read ahead size from 4 to 8, or disable CDXCACHE altogether (see README.TXT).
• Use SMARTDRV instead of CDXCACHE.

7. Do not allow any foreign object to get inside this equipment. Do not place small objects on or near this equipment.
8. Do not expose this equipment to direct sunlight for long periods of time or near radiators or other heat sources.
9. Do not operate this equipment in a dusty or humid environment, or where cigarette smoke is prevalent.

CD-ROM drive - Quick reference guide

Figure 1 Front view

Figure 2 Rear view

- Mounting screw holes (8 x M3 x 8mm)
System Requirements

This Panasonic SCSI CD-ROM drive is designed for use in most IBM compatible computer systems with a free 5.25" drive bay and a SCSI interface or SCSI host adapter installed.

If your system does not already have a SCSI interface or SCSI host adapter installed, and your system has a free ISA slot, you are recommended to use our SCSI CD-ROM kit which comes complete with an Adaptec AHA1520A or AHA1520B SCSI host adapter.

If you intend to use other SCSI peripherals such as hard disk drives, and/or your system has alternative bus technology such as EISA, Micro Channel, VL Bus or PCI Bus, you can use the bare drive kit with a third party SCSI host adapter designed for your computers Bus, provided it is supplied with an ASPI manager.

The operating system requirement is:

- PC-DOS Ver 6.0 or later or MS-DOS Ver 6.0 or later.
- MS Windows 3.1 or later, MS Windows for workgroups 3.11.
- MS Windows NT 3.5 or later, Windows 95 or
- OS/2 2.1x or later.

Hardware Installation

Important safety notice:

To avoid electric shock ensure that your computer is turned off and the AC power cord is removed from the mains socket before removing the top cover of your computer.

1. Remove the top cover of your computer. For more information, see your computer’s manual.
2. If your system already has a SCSI interface or SCSI host adapter installed proceed from “Installing the CD-ROM drive” on page 6. If you are installing a third party SCSI adapter follow the instruction supplied with it. Otherwise proceed with the instructions for installing our (optional) interface card below.

(Optional) interface card

The optional interface card supplied with the drive kit is the AHA-1520A or AHA1520B from Adaptec, Milpitas, California, USA. The termination and jumper settings of this card have been pre-configured to operate in most ISA computers with the CD-ROM drive as the only device to be connected. In most cases you will not need to change these settings and the following instructions will be sufficient to install this card.

If, however, you need to connect additional devices to this card, or you have conflicts with other options installed in your computer you may need to change the termination or jumper settings. Please refer to the enclosed Installation guide from Adaptec for more detailed information. Then proceed as follows (refer also to figure 3).

4. Close the devices window and close control panel.
5. Restart the system to enable the changes made and configure the CD-ROM drive.

CD-ROM operation under Windows NT

1. Your CD-ROM drive will appear in File Manager, indicated by a CD icon. For data CDs click on the icon to display the disk contents.
2. Audio CDs can be played using Media Player which is installed in the Accessories folder.

Guide to operation

1. Power up your computer.
2. Press the eject button on the CD-ROM drive to open the loading tray.
3. Place the disk in the tray with the label side facing up.
4. Press the eject button or push the loading tray lightly in. The tray will be retracted automatically.
5. Wait for the busy LED to go out before trying to read the CD-ROM or play the CD. If you try to read or play the disc before the LED goes out an error will be displayed. Wait for the LED to go out and retry the operation.
6. In case of emergency such as power failure, you can eject the tray manually. Insert a straightened paper clip with a minimum straight length of 45 mm and diameter of 1 to 1.5 mm into the emergency eject hole and push in until the tray is slightly ejected. Remove the paper clip and open the tray fully by pulling out. After removing the CD push the tray back in fully to prevent damage. Normal operation will be restored once power is reapplied.

Maintenance and Care Instructions

CD-ROM drive

- Do not insert foreign objects into the tray.
- Do not try to manually force the tray open, other than explained above.
- When the drive is not in use keep the tray closed.
- Do not push down on the tray whilst it is open.

CD, CD-ROMs

Take care when handling CDs not to touch the surface, and keep free from dust and scratches. Do not expose to extremes of temperature and humidity. Never use bent or damaged CDs. If CDs become dirty, clean carefully with a soft cloth moistened with water and remove any remaining moisture with a soft dry cloth. Always wipe the disc from the centre out towards the edge. Never wipe circularly round the disc.
If you are using our optional AHA-1520B host adapter or other plug and play host adapter, all you need to do is start Windows 95. The following message will be displayed: "Windows has found new hardware and is installing software for it".

**CD-ROM operation under Windows 95**
1. Your CD-ROM drive will appear in My Computer folder, indicated by a CD icon. Click on the icon to display the disk contents.
2. You can software eject the CD disk by clicking on the drive icon with the left mouse button, and clicking on Eject disk.
3. Audio CDs can be played using the CD Player which is installed in the Multimedia folder in Accessories. You can also play tracks by clicking on the CD drive icon and clicking on the track you want to play.

**Windows NT Systems**
The SCSI CD-ROM drive can be installed on a Windows NT System using the embedded CD-ROM driver.

**Installing Windows NT using the CD-ROM drive**
This procedure assumes that you are installing the SCSI CD-ROM drive and Windows NT CD-ROM version for the first time on your computer. If you have already installed Windows NT or are installing it using a floppy disk version, please proceed from "Installing the SCSI CD-ROM drive on a Windows NT system". Otherwise, proceed as follows:
1. Install the hardware as instructed on page 5.
2. Insert the Windows NT Setup diskette 1 in the A: drive. Boot up the system.
3. Follow the instructions on the screen inserting diskettes 2 and 3 when instructed.
4. The Windows NT installation diskettes will automatically detect the SCSI adapter/CD-ROM drive and give you the option to continue installation using the CD-ROM.
5. Press <Enter> to continue. Follow the Windows NT installation instructions to complete the installation. The CD-ROM drive will be automatically configured.

**Installing the CD-ROM drive on a Windows NT system**
The following procedure assumes that you have already installed the Windows NT operating system on your computer, and have added the SCSI CD-ROM drive hardware according to the instructions on page 4.
1. Startup Windows NT and open Windows NT Control Panel. Use the Devices option to configure device startup.
2. If your SCSI adapter device manager is already running proceed from 4 (below). Otherwise select the device manager for your SCSI adapter (if using our optional host adapter AHA-1520x the device manager is called SPARROW) and click on the button Startup. Set the startup value to Boot.
3. Select the device Scsicdrm and click on the button Startup. Set the startup value to System.
Installing the CD-ROM drive

1. Jumper settings. (see figure 2 and table below). The SCSI CD-ROM drive is shipped with default jumper settings as shown on the right. For an explanation of these jumper settings please refer to the following table.

<table>
<thead>
<tr>
<th>SCSI ID settings:</th>
<th>Parity/Sector size</th>
<th>Terminator jumpers</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID:0</td>
<td>Default setting is ON. For normal operation do not change this setting.</td>
<td></td>
</tr>
<tr>
<td>ID:1</td>
<td>Default setting is OFF. (sector size 2048 Bytes/Block.)</td>
<td></td>
</tr>
<tr>
<td>ID:2</td>
<td>To select sector size of 512 Bytes/Block install the jumper.</td>
<td></td>
</tr>
<tr>
<td>ID:3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID:4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID:5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID:6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID:7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Install the CD-ROM drive into a free drive bay (A) using the 4 x M3 screws provided.

   Please note that some computers will need special mounting rails or other fixing methods to secure the drive into the drive bay. For more information, see your computers manual.

3. Connect the SCSI interface:

   Connect the SCSI cable (C) supplied to the SCSI interface connector (D) on your computers motherboard or SCSI host adapter. If the connectors are not polarised make sure that pin 1 of the cable is connected to pin 1 of each connector. Connect the other end of the cable to the SCSI connector on the CD-ROM drive (B). A spare connector is provided on the cable to allow connection of another internal device such as a hard disk drive if required.

9. When prompted for the Source Directory enter A: and click Install. Follow the instructions displayed to complete the installation.

10. When completed, shutdown your system and restart OS/2 to enable the changes made to your system.

CD-ROM operation under OS/2

1. Your CD-ROM drive will appear in your drives folder, indicated by a CD icon. Click on the icon to display the disk contents.

2. Drive utilities are obtained by clicking with the right mouse button on the icon.

   - Eject disk - opens the CD-ROM drive tray.
   - Lock disk - Locks the CD-ROM drive tray, and disables the eject button.
   - Unlock disk - Unlocks the CD-ROM drive tray, and enables the eject button.

3. Audio CDs can be played using the CD Player which is installed in the Multimedia folder.

Windows 95 Systems

The SCSI CD-ROM drive can be installed on a Windows 95 System using the embedded CD-ROM driver.

Installing Windows 95 using the CD-ROM drive

This procedure assumes that you are installing the CD-ROM drive and Windows 95 CD-ROM version for the first time on your computer. If you have already installed Windows 95 or are installing it using a floppy disk version, please proceed from “Installing the SCSI CD-ROM drive on a Windows 95 system”. Otherwise, proceed as follows:

1. Install the hardware as instructed earlier.

2. Install the CD-ROM DOS device drivers as instructed earlier.

3. Insert the Windows 95 CD in the CD-ROM drive and change to the CD-ROM drive e.g., D: and type Setup at the command prompt.

4. Follow the Windows 95 setup instructions.

5. The Windows 95 installation routine will automatically detect the hardware and install the drivers for your CD-ROM drive.

Installing the CD-ROM drive on a Windows 95 system

The following procedure assumes that you have already installed the Windows 95 operating system on your computer, and have added the SCSI CD-ROM drive hardware according to the instructions.

Depending on the SCSI host adapter used, please proceed as follows:

1. If you are using our optional AHA-1520A host adapter or other Windows 95 supported host adapter, which is not plug and play, start Windows 95, then open the Windows 95 Control panel and click on Add New Hardware.

   Follow the instructions on the screen to complete the installation.
3. Create wallpaper for your system.
4. Run slide shows of images.
5. Build catalogues of information about images.

- To open Corel Photo CD Lab
  Double click the Photo CD Lab icon in the CorelSCSI program group.
- To exit Corel Photo CD Lab
  Select Exit from the File menu.

OS/2 Systems
The SCSI CD-ROM drive can be installed on an IBM OS/2 System using the OS/2 embedded CD-ROM driver.

Installing OS/2 from the CD-ROM drive
This procedure assumes that you are installing the SCSI CD-ROM drive and OS/2 CD-ROM version for the first time on your computer. If you have already installed OS/2 or are installing it using a floppy disk version, please proceed from “Installing the SCSI CD-ROM drive on an OS/2 system”. Otherwise, proceed as follows:
1. Install the hardware according to the instructions on page 5.
2. Follow the installation instructions for installing the Operating System as provided by IBM. The SCSI CD-ROM drive will be automatically detected by using the two installation diskettes provided with the CD-ROM version, and installation will then proceed from the CD-ROM.
3. When the installation of OS/2 is completed, your computer will automatically be restarted from the hard disk. For OS/2 Warp, installation of the CD-ROM device driver will be simultaneously completed.

Installing the CD-ROM drive on an OS/2 system
The following procedure assumes that you have already installed the OS/2 operating system on your computer, and have completed the hardware installation according to the instructions.
1. Make installation diskettes 2 and 3 from the diskette images on the OS/2 CD-ROM. Refer to your OS/2 Instruction manual for details.
2. Startup your computer and boot OS/2.
3. Open the OS/2 System icon.
4. Open the System Setup icon.
5. Open the Selective Install icon.
6. If a SCSI adapter is not already set up, select the SCSI adapter which is installed in your system from the drop down list under SCSI adapter support.
7. Then select Other from the drop down list under CD-ROM support.
8. Click OK followed by Install.

4. For sound, connect the audio cable supplied to the audio-out socket (E) on your CD-ROM drive and to the audio-in socket on a sound card (not supplied).
5. Connect an auxiliary power cord (F) from your computer's power supply to the power socket (G) on the CD-ROM drive.
6. Replace the top cover of your computer.

Figure 4 CD-ROM drive installation
Software Installation

DOS Systems

The device driver supplied with your CD-ROM drive is CorelSCSI!™ licensed from Corel Corporation, Ottawa, Ontario, Canada. CorelSCSI! includes additional utility software that will be convenient (or necessary) depending on the existing configuration of your computer and the applications you want to run.

You can install CorelSCSI! on any IBM compatible PC running DOS 4.0 or higher. It can also be installed from Windows 3.1 or higher.

Quick Installation

The following instructions are sufficient to install the CorelSCSI CD-ROM drivers on most IBM compatible DOS systems. In the unlikely event that you encounter problems or if you require more detailed information, refer to the readme files, which can be viewed on the installation diskette using any standard wordprocessor or by using the TYPE command (refer to your DOS documentation for more details).

Note: If you are using a memory manager, you must exclude the address of your SCSI host adapter in the CONFIG.SYS file to prevent conflicts between the memory manager and the host adapter.

For example, if you are using the EMM386 memory manager and a host adapter that covers the address range from dc00 to dfff, you would specify the following in your CONFIG.SYS file:

DEVICE=C:\DOS\EMM386.EXE x=dc00-dfff

Insert the CorelSCSI disk 1 in drive A: and make this drive your current drive.

1. Enter the following at the command prompt: DOSSETUP.
2. Select Continue.
3. If the installation detects Windows on your system, you are prompted to exit the DOS installation and install under Windows or to continue the installation under DOS.
4. Select Continue to accept the default directory. Or enter the full directory path where you want CorelSCSI installed and select Continue.
5. Select the CD-ROM driver to load it into high memory and select Continue.
6. Select Continue to accept the default number of available drive letters. Or enter a new number and select Continue. You require one drive letter for the CD-ROM drive.
7. CorelSCSI includes ASPI managers for most common SCSI host adapters, select the ASPI manager for the host adapter you’ve installed. If you use the optional host adapter supplied with the drive kit, you should select Adaptec ‘ASPI2DOS’ ASPI manager.
8. Select Update to make the required changes to CONFIG.SYS and AUTOEXEC.BAT files. If you choose Do Not Update, the modified CONFIG.SYS and AUTOEXEC.BAT files are saved in the root directory as CONFIG.00n and AUTOEXEC.00n. Where the value of n starts at 0.
9. If you’re prompted to replace CorelCDX, select Yes.

Checking the installation

1. During system boot-up check for any error messages.
2. After system boot up, start Windows and select SCSITools from the CorelSCSI group. (For more details about using SCSITools please refer to the Tools online help).
3. Select Device List by clicking the icon.
4. Check that one drive letter is assigned to the CD-ROM drive, such as Drive D:
5. From the file menu, select Exit.

Using the SCSI CD-ROM drive

1. To use the CD-ROM drive use the drive letter found above.
2. When loading a disk the drive busy light will flicker. Please wait until the busy light goes out before accessing the disk, otherwise the following error will be displayed: ‘There is no disk in drive X (where X is the selected drive letter)
   Insert a disk, and then try again.’
   If this should occur, please select Retry after the busy light has gone out, and the drive will access normally.

Windows Utilities

SCSI Tools

The SCSITools utility provides the following utilities required to manage your CD-ROM drive. It also includes an on-line help facility. To open SCSITools double click the SCSITools icon in the CorelSCSI program group.

1. Select File, to use log files to record information generated by Tools, and to change the Tools preferences.
2. Select Status, to obtain status information about your CD-ROM drive, discs and device drivers.
For example, if you are using the EMM386 memory manager and a host adapter that covers the address range from dc00 to dfff, you would specify the following in your CONFIG.SYS file:

```
DEVICE=C:\DOS\EMM386.EXE x=dc00-dfff
```

Note: When installing under Windows, you must add the following line to the [386Enh] section of your SYSTEM.INI file to prevent Windows from using the memory space used by the host adapter:

```
EMMEXCLUDE=adapter_address
```

For example if you are using a host adapter that uses the address range from dc00 to dfff, you would enter:

```
EMMEXCLUDE=dc00-dfff
```

1. Start Windows.
2. Insert the CorelSCSI disk 1 in drive A:
3. Select Run from the File menu of the Program Manager.
4. Enter A:\SETUP.
5. Select Continue to accept the default directory. Or enter the full directory path where you want CorelSCSI installed and select Continue.
6. CorelSCSI includes ASPI managers for most common SCSI host adapters, select the ASPI manager for the host adapter you’ve installed. If you use the optional host adapter supplied with the drive kit, you should select Adaptec ‘ASPI2DOS’ ASPI manager.
7. Select the CD-ROM driver to load it into high memory and select Continue.
8. Select Continue to accept the default number of available drive letters. Or enter a new number and select Continue. You require one drive letter for the CD-ROM drive.
9. Select Update to make the required changes to CONFIG.SYS and AUTOEXEC.BAT files. If you choose Do Not Update, the modified CONFIG.SYS and AUTOEXEC.BAT files are saved in the root directory as CONFIG.00n and AUTOEXEC.00n. Where the value of n starts at 0.
10. If you’re prompted to replace CorelCDX, select Yes.
11. Select View for product information that wasn’t available when the documentation was printed and then select Continue.
12. Choose Reboot to restart your system using the modified CONFIG.SYS and AUTOEXEC.BAT files.

Your SCSI CD-ROM drive may not have been automatically detected after installation and will therefore only support Single Session discs. For full support, including Multi-Session discs, please complete the installation, by performing the following procedure.

1. At the command prompt, enter DOSCONFG
2. Select Continue
3. Select CD-ROM
4. Select Add Device
5. Select ADD =
6. Select SCAN
7. Highlight and select the CD-ROM drive
8. Select Panasonic CR-504 from the supported list
9. Select Install
10. Select Close, Back, Exit, Yes and re-start your system

Checking the installation
1. During system boot-up check for any error messages.
2. After system boot up, check installation by entering the following at the command prompt: DOSTOOLS. (For more details about using DOSTOOLS please refer to the online help).
3. Select Device List from the Device menu (ALT+D).
4. Check that one drive letter is assigned to the CD-ROM drive, such as Drive D:
5. Select Exit from the File menu (Alt+F).

Using the SCSI CD-ROM drive
1. To use the CD-ROM drive, use the drive letter found above.
2. When loading a disk the drive busy light will flicker. Please wait until the busy light goes out before accessing the disk, otherwise the following error will be displayed:
   ‘Not ready reading drive X (where X is the selected drive letter)
   Abort, Retry, Fail?’
   If this should occur, please press R (for retry) after the busy light has gone out, and the drive will access normally.
3. Select Maintenance to run diagnostics on your CD-ROM drive.
4. Select Utility to perform various utilities:
   - Inquire about the selected device.
   - Scan the SCSI bus to identify devices attached to it.
   - Lock and unlock the drive tray.
   - Eject the media.

CD-Audio
Using CD-Audio, you can play your audio CDs on the CD-ROM drive. The CD-Audio utility provides functions similar to those of a domestic CD player, allowing you to play, pause, stop and eject CDs. You can also shuffle and repeat tracks, as well as program the order in which you want tracks played. CD-Audio also includes features for listening to portions of tracks.

CD-Audio can also store customised information regarding your audio CDs in a database file. If you use Microsoft Music Box databases, CD-Audio will copy the disk information to the CD-Audio database, the first time you insert the disk.
   - To open CD-Audio
   Double click the CD-Audio icon in the CorelSCSI program group. By default, CD-Audio opens using the remote (small) window. To see the full window, select it from the View menu. The following table describes how to use the buttons on this utility.

[Buttons and Descriptions]

Corel Photo CD Lab
You can work with Kodak Photo CD images using Corel Photo CD Lab. This utility lets you perform the following:
1. Modify image resolution, colour and rotation.
2. Convert images to BMP, EPS, PCX and TIF formats.

Dos Utilities
DOSTOOLS
The DOSTOOLS utility provides the following utilities required to manage your CDROM drive. It also includes an on-line help facility. To open DOSTOOLS enter the following at the command prompt: DOSTOOLS.
1. Select File, to use log files to record information generated by Tools, and to change the Tools preferences.
2. Select Status, to obtain status information about your CD-ROM drive, discs and device drivers.
3. Select Maintenance, to run diagnostics on your CD-ROM drive.
4. Select Utility, to perform various utilities:
   - Inquire about the selected device.
   - Scan the SCSI bus to identify devices attached to it.
   - Lock and unlock the drive tray.
   - Eject the media.

DOSAUDIO
Using DOSAUDIO, you can play your audio CDs on the CD-ROM drive. The DOSAUDIO utility provides functions similar to those of a domestic CD player, allowing you to play, pause, stop and eject CDs. You can also shuffle and repeat tracks, as well as program the order in which you want tracks played.

CD-Audio can also store customised information regarding your audio CDs in a database file. If you use Microsoft Music Box databases, CD-Audio will copy the disk information to the CD-Audio database, the first time you insert the disk.
   - To open DOSAUDIO
   Enter the following at the command prompt: DOSAUDIO
   - To exit DOSAUDIO
   Press the right mouse button, or press ESC.

Windows Systems
The Device Driver supplied with your CD-ROM drive is ‘CorelSCSI!’ licensed from Corel Corporation, Ontario, Canada. CorelSCSI includes additional utility software that will be convenient (or necessary) depending on the existing configuration of your computer and the applications you want to run.

You can install CorelSCSI on any IBM compatible PC running DOS 4.0 or higher and Windows 3.1 or higher, or Windows for Workgroups 3.11.

Quick Installation
The following instructions are sufficient to install the CorelSCSI! CD-ROM drivers on most IBM compatible Windows systems. In the unlikely event that you encounter problems or if you require more detailed information, refer to the readme files which can viewed on the installation diskette using any standard word processor or by using Notepad in Windows (refer to your Windows documentation for more details).

Note: If you are using a memory manager, you must exclude the address of your SCSI host adapter in the CONFIG.SYS file to prevent conflicts between the memory manager and the host adapter.
3. Select Maintenance to run diagnostics on your CD-ROM drive.
4. Select Utility to perform various utilities:
   - Inquire about the selected device.
   - Scan the SCSI bus to identify devices attached to it.
   - Lock and unlock the drive tray.
   - Eject the media.

CD-Audio
Using CD-Audio, you can play your audio CDs on the CD-ROM drive. The CD-Audio utility provides functions similar to those of a domestic CD player, allowing you to play, pause, stop and eject CDs. You can also shuffle and repeat tracks, as well as program the order in which you want tracks played. CD-Audio also includes features for listening to portions of tracks.

CD-Audio can also store customised information regarding your audio CDs in a database file. If you use Microsoft Music Box databases, CD-Audio will copy the disk information to the CD-Audio database, the first time you insert the disk.

   - To open CD-Audio
     Double click the CD-Audio icon in the CorelSCSI program group. By default, CD-Audio opens using the remote (small) window. To see the full window, select it from the View menu. The following table describes how to use the buttons on this utility.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play or resume after pausing.</td>
<td>Play or resume after pausing.</td>
</tr>
<tr>
<td>Pause play and resume play from where you paused.</td>
<td>Pause play and resume play from where you paused.</td>
</tr>
<tr>
<td>Stop play.</td>
<td>Stop play.</td>
</tr>
<tr>
<td>Eject the CD-ROM disk.</td>
<td>Eject the CD-ROM disk.</td>
</tr>
<tr>
<td>Repeat play.</td>
<td>Repeat play.</td>
</tr>
<tr>
<td>Shuffle play.</td>
<td>Shuffle play.</td>
</tr>
</tbody>
</table>

   - To exit CD-Audio
     Select Exit from the Play menu.

Corel Photo CD Lab
You can work with Kodak Photo CD images using Corel Photo CD Lab. This utility lets you perform the following:
1. Modify image resolution, colour and rotation.
2. Convert images to BMP, EPS, PCX and TIF formats.

DOS Utilities

DOSTOOLS
The DOSTOOLS utility provides the following utilities required to manage your CDROM drive. It also includes an on-line help facility. To open DOSTOOLS enter the following at the command prompt: DOSTOOLS.
1. Select File, to use log files to record information generated by Tools, and to change the Tools preferences.
2. Select Status, to obtain status information about your CD-ROM drive, discs and device drivers.
3. Select Maintenance, to run diagnostics on your CD-ROM drive.
4. Select Utility, to perform various utilities:
   - Inquire about the selected device.
   - Scan the SCSI bus to identify devices attached to it.
   - Lock and unlock the drive tray.
   - Eject the media.

DOSAUDIO
Using DOSAUDIO, you can play your audio CDs on the CD-ROM drive. The DOSAUDIO utility provides functions similar to those of a domestic CD player, allowing you to play, pause, stop and eject CDs. You can also choose the tracks that you want played and the type of status information, either disk or track, that you want displayed.

   - To open DOSAUDIO
     Enter the following at the command prompt: DOSAUDIO
   - To exit DOSAUDIO
     Press the right mouse button, or press ESC.

Windows Systems
The Device Driver supplied with your CD-ROM drive is ‘CorelSCSI’ licensed from Corel Corporation, Ontario, Canada. CorelSCSI includes additional utility software that will be convenient (or necessary) depending on the existing configuration of your computer and the applications you want to run.

You can install CorelSCSI on any IBM compatible PC running DOS 4.0 or higher and Windows 3.1 or higher, or Windows for Workgroups 3.11.

Quick Installation
The following instructions are sufficient to install the CorelSCSI CD-ROM drivers on most IBM compatible Windows systems. In the unlikely event that you encounter problems or if you require more detailed information, refer to the readme files which can viewed on the installation diskette using any standard word processor or by using Notepad in Windows (refer to your Windows documentation for more details).

   - Note: If you are using a memory manager, you must exclude the address of your SCSI host adapter in the CONFIG.SYS file to prevent conflicts between the memory manager and the host adapter.
For example, if you are using the EMM386 memory manager and a host
adapter that covers the address range from dc00 to dfff, you would specify
the following in your CONFIG.SYS file:

DEVICE=C:\DOS\EMM386.EXE x=dc00-dfff

Note: When installing under Windows, you must add the following line to the [386Enh]
section of your SYSTEM.INI file to prevent Windows from using the memory
space used by the host adapter:

EMMEXCLUDE=adapter_address

For example if you are using a host adapter that uses the address range from
dc00 to dfff, you would enter:

EMMEXCLUDE=dc00-dfff

1. Start Windows.
2. Insert the CorelSCSI disk 1 in drive A:
3. Select Run from the File menu of the Program Manager.
4. Enter A:\SETUP.
5. Select Continue to accept the default directory or enter the full directory path where
you want CorelSCSI installed and select Continue.
6. CorelSCSI includes ASPI managers for most common SCSI host adapters, select the
ASPI manager for the host adapter you've installed. If you use the optional host
adapter supplied with the drive kit, you should select Adaptec 'ASPI2DOS' ASPI
manager.
7. Select the CD-ROM driver to load it into high memory and select Continue.
8. Select Continue to accept the default number of available drive letters. Or enter a new
number and select Continue. You require one drive letter for the CD-ROM drive.
9. Select Update to make the required changes to CONFIG.SYS and AUTOEXEC.BAT
files. If you choose Do Not Update, the modified CONFIG.SYS and AUTOEXEC.BAT
files are saved in the root directory as CONFIG.00n and AUTOEXEC.00n. Where the
value of n starts at 0.
10. If you're prompted to replace CorelCDX, select Yes.
11. Select View for product information that wasn't available when the documentation was
printed and then select Continue.
12. Choose Reboot to restart your system using the modified CONFIG.SYS and
AUTOEXEC.BAT files.

Your SCSI CD-ROM drive may not have been automatically detected after installation and
will therefore only support Single Session discs. For full support, including Multi-Session
discs, please complete the installation, by performing the following procedure.
1. At the command prompt, enter DOSCONFG
2. Select Continue
3. Select CD-ROM
4. Select Add Device
5. Select ADD =
6. Select SCAN
7. Highlight and select the CD-ROM drive
8. Select Panasonic CR-504 from the supported list
9. Select Install
10. Select Close, Back, Exit, Yes and re-start your system

Checking the installation
1. During system boot-up check for any error messages.
2. After system boot up, check installation by entering the following at the command
prompt: DOSTOOLS. (For more details about using DOSTOOLS please refer to the
online help).
3. Select Device List from the Device menu (ALT+D).
4. Check that one drive letter is assigned to the CD-ROM drive, such as Drive D:
5. Select Exit from the File menu (Alt+F).

Using the SCSI CD-ROM drive
1. To use the CD-ROM drive, use the drive letter found above.
2. When loading a disk the drive busy light will flicker. Please wait until the busy light
goes out before accessing the disk, otherwise the following error will be displayed:
   'Not ready reading drive X (where X is the selected drive letter)
   Abort, Retry, Fail?'
   If this should occur, please press R (for retry) after the busy light has gone out, and the
drive will access normally.
Your SCSI CD-ROM drive may not have been automatically detected after installation and will therefore only support Single Session discs. For full support, including Multi-Session discs, please complete the installation, by performing the following procedure.

1. Double click SCSIConfig icon in the CorelSCSI 2 program group
2. From the Window menu, select CD Drivers
3. From the CD-Rom menu, select Devices
4. Click Edit button
5. Click Add » button
6. Click Scan button
7. Highlight the CD-ROM and click Select
8. Select Panasonic CR-504 from the CD-ROM compatibility list
9. Click Install
10. Click Close button
11. Close Windows and re-start your system

Checking the installation
1. During system boot-up check for any error messages.
2. After system boot up, start Windows and select SCSITools from the CorelSCSI group.
   (For more details about using SCSITools please refer to the Tools online help).
3. Select Device List by clicking the icon.
4. Check that one drive letter is assigned to the CD-ROM drive, such as Drive D:
5. From the file menu, select Exit.

Using the SCSI CD-ROM drive
1. To use the CD-ROM drive use the drive letter found above.
2. When loading a disk the drive busy light will flicker. Please wait until the busy light goes out before accessing the disk, otherwise the following error will be displayed:
   ‘There is no disk in drive X (where X is the selected drive letter)
   Insert a disk, and then try again.’
   If this should occur, please select Retry after the busy light has gone out, and the drive will access normally.

Windows Utilities
SCSI Tools
The SCSITools utility provides the following utilities required to manage your CD-ROM drive. It also includes an on-line help facility. To open SCSITools double click the SCSITools icon in the CorelSCSI program group.
1. Select File, to use log files to record information generated by Tools, and to change the Tools preferences.
2. Select Status, to obtain status information about your CD-ROM drive, discs and device drivers.
3. Create wallpaper for your system.
4. Run slide shows of images.
5. Build catalogues of information about images.

- To open Corel Photo CD Lab
  Double click the Photo CD Lab icon in the CorelSCSI program group.
- To exit Corel Photo CD Lab
  Select Exit from the File menu.

OS/2 Systems
The SCSI CD-ROM drive can be installed on an IBM OS/2 System using the OS/2 embedded CD-ROM driver.

Installing OS/2 from the CD-ROM drive
This procedure assumes that you are installing the SCSI CD-ROM drive and OS/2 CD-ROM version for the first time on your computer. If you have already installed OS/2 or are installing it using a floppy disk version, please proceed from “Installing the SCSI CD-ROM drive on an OS/2 system”. Otherwise, proceed as follows:
1. Install the hardware according to the instructions on page 5.
2. Follow the installation instructions for installing the Operating System as provided by IBM. The SCSI CD-ROM drive will be automatically detected by using the two installation diskettes provided with the CD-ROM version, and installation will then proceed from the CD-ROM.
3. When the installation of OS/2 is completed, your computer will automatically be restarted from the hard disk. For OS/2 Warp, installation of the CD-ROM device driver will be simultaneously completed.

Installing the CD-ROM drive on an OS/2 system
The following procedure assumes that you have already installed the OS/2 operating system on your computer, and have completed the hardware installation according to the instructions.
1. Make installation diskettes 2 and 3 from the diskette images on the OS/2 CD-ROM. Refer to your OS/2 Instruction manual for details.
2. Startup your computer and boot OS/2.
3. Open the OS/2 System icon.
4. Open the System Setup icon.
5. Open the Selective Install icon.
6. If a SCSI adapter is not already set up, select the SCSI adapter which is installed in your system from the drop down list under SCSI adapter support.
7. Then select Other from the drop down list under CD-ROM support.
8. Click OK followed by Install.

4. For sound, connect the audio cable supplied to the audio-out socket (E) on your CD-ROM drive and to the audio-in socket on a sound card (not supplied).
5. Connect an auxiliary power cord (F) from your computers power supply to the power socket (G) on the CD-ROM drive.
6. Replace the top cover of your computer.
Installing the CD-ROM drive

1. Jumper settings. (see figure 2 and table below). The SCSI CD-ROM drive is shipped with default jumper settings as shown on the right. For an explanation of these jumper settings please refer to the following table.

<table>
<thead>
<tr>
<th>SCSI ID settings:</th>
<th>Parity/Sector size</th>
<th>Terminator jumpers</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID:0</td>
<td>Default setting is ON. For normal operation do not change this setting.</td>
<td></td>
</tr>
<tr>
<td>ID:1</td>
<td>Default setting is OFF. (sector size 2048 Bytes/Block.)</td>
<td></td>
</tr>
<tr>
<td>ID:2</td>
<td>To select sector size of 512 Bytes/Block install the jumper.</td>
<td></td>
</tr>
<tr>
<td>ID:3</td>
<td>TERM POWER must be supplied by at least one SCSI device on the bus. When term power is not supplied by another device, set TERM POWER ON:</td>
<td></td>
</tr>
<tr>
<td>ID:4</td>
<td>TERM POWER must be supplied by at least one SCSI device on the bus. When term power is not supplied by another device, set TERM POWER ON:</td>
<td></td>
</tr>
<tr>
<td>ID:5</td>
<td>TERM POWER must be supplied by at least one SCSI device on the bus. When term power is not supplied by another device, set TERM POWER ON:</td>
<td></td>
</tr>
<tr>
<td>ID:6</td>
<td>TERM POWER must be supplied by at least one SCSI device on the bus. When term power is not supplied by another device, set TERM POWER ON:</td>
<td></td>
</tr>
<tr>
<td>ID:7</td>
<td>TERM POWER must be supplied by at least one SCSI device on the bus. When term power is not supplied by another device, set TERM POWER ON:</td>
<td></td>
</tr>
</tbody>
</table>

2. Install the CD-ROM drive into a free drive bay (A) using the 4 x M3 screws provided. Please note that some computers will need special mounting rails or other fixing methods to secure the drive into the drive bay. For more information, see your computer’s manual.

3. Connect the SCSI interface:
Connect the SCSI cable (C) supplied to the SCSI interface connector (D) on your computer’s motherboard or SCSI host adapter. If the connectors are not polarised make sure that pin 1 of the cable is connected to pin 1 of each connector. Connect the other end of the cable to the SCSI connector on the CD-ROM drive (B). A spare connector is provided on the cable to allow connection of another internal device such as a hard disk drive if required.

9. When prompted for the Source Directory enter A:\ and click Install. Follow the instructions displayed to complete the installation.

10. When completed, shutdown your system and restart OS/2 to enable the changes made to your system.

CD-ROM operation under OS/2
1. Your CD-ROM drive will appear in your drives folder, indicated by a CD icon. Click on the icon to display the disk contents.

2. Drive utilities are obtained by clicking with the right mouse button on the icon.
   - Eject disk - opens the CD-ROM drive tray.
   - Lock disk - locks the CD-ROM drive tray and disables the eject button.
   - Unlock disk - unlocks the CD-ROM drive tray and enables the eject button.

3. Audio CDs can be played using the CD Player which is installed in the Multimedia folder.

Windows 95 Systems
The SCSI CD-ROM drive can be installed on a Windows 95 System using the embedded CD-ROM driver.

Installing Windows 95 using the CD-ROM drive
This procedure assumes that you are installing the CD-ROM drive and Windows 95 CD-ROM version for the first time on your computer. If you have already installed Windows 95 or are installing it using a floppy disk version, please proceed from “Installing the SCSI CD-ROM drive on a Windows 95 system”. Otherwise, proceed as follows:
1. Install the hardware as instructed earlier.
2. Install the CD-ROM DOS device drivers as instructed earlier.
3. Insert the Windows 95 CD in the CD-ROM drive and change to the CD-ROM drive e.g., D: and type Setup at the command prompt.
4. Follow the Windows 95 setup instructions.
5. The Windows 95 installation routine will automatically detect the hardware and install the drivers for your CD-ROM drive.

Installing the CD-ROM drive on a Windows 95 system
The following procedure assumes that you have already installed the Windows 95 operating system on your computer, and have added the SCSI CD-ROM drive hardware according to the instructions.
Depending on the SCSI host adapter used, please proceed as follows:
1. If you are using our optional AHA-1520A host adapter or other Windows 95 supported host adapter, which is not plug and play, start Windows 95, then open the Windows 95 Control panel and click on Add New Hardware.
   Follow the instructions on the screen to complete the installation.
2. If you are using our optional AHA-1520B host adapter or other plug and play host adapter, all you need to do is start Windows 95. The following message will be displayed: "Windows has found new hardware and is installing software for it".

CD-ROM operation under Windows 95
1. Your CD-ROM drive will appear in My Computer folder, indicated by a CD icon. Click on the icon to display the disk contents.
2. You can software eject the CD disk by clicking on the drive icon with the left mouse button, and clicking on Eject disk.
3. Audio CDs can be played using the CD Player which is installed in the Multimedia folder in Accessories. You can also play tracks by clicking on the CD drive icon and clicking on the track you want to play.

Windows NT Systems
The SCSI CD-ROM drive can be installed on a Windows NT System using the embedded CD-ROM driver.

Installing Windows NT using the CD-ROM drive
This procedure assumes that you are installing the SCSI CD-ROM drive and Windows NT CD-ROM version for the first time on your computer. If you have already installed Windows NT or are installing it using a floppy disk version, please proceed from “Installing the SCSI CD-ROM drive on a Windows NT system”. Otherwise, proceed as follows:
1. Install the hardware as instructed on page 5.
2. Insert the Windows NT Setup diskette 1 in the A: drive. Boot up the system.
3. Follow the instructions on the screen inserting diskettes 2 and 3 when instructed.
4. The Windows NT installation diskettes will automatically detect the SCSI adapter/CD-ROM drive and give you the option to continue installation using the CD-ROM.
5. Press <Enter> to continue. Follow the Windows NT installation instructions to complete the installation. The CD-ROM drive will be automatically configured.

Installing the CD-ROM drive on a Windows NT system
The following procedure assumes that you have already installed the Windows NT operating system on your computer, and have added the SCSI CD-ROM drive hardware according to the instructions on page 4.
1. Startup Windows NT and open Windows NT Control Panel. Use the Devices option to configure device startup.
2. If your SCSI adapter device manager is already running proceed from 4 (below). Otherwise select the device manager for your SCSI adapter (if using our optional host adapter AHA-1520x the device manager is called SPARROW) and click on the button Startup. Set the startup value to Boot.
3. Select the device Scsicdrm and click on the button Startup. Set the startup value to System.
System Requirements
This Panasonic SCSI CD-ROM drive is designed for use in most IBM compatible computer systems with a free 5.25” drive bay and a SCSI interface or SCSI host adapter installed.

If your system does not already have a SCSI interface or SCSI host adapter installed, and your system has a free ISA slot, you are recommended to use our SCSI CD-ROM kit which comes complete with an Adaptec AHA1520A or AHA1520B SCSI host adapter.

If you intend to use other SCSI peripherals such as hard disk drives, and/or your system has alternative bus technology such as EISA, Micro Channel, VLB Bus or PCI Bus, you can use the bare drive kit with a third party SCSI host adapter designed for your computer, provided it is supplied with an ASPI manager.

The operating system requirement is:
- PC-DOS Ver 6.0 or later or MS-DOS Ver 6.0 or later.
- MS Windows 3.1 or later, MS Windows for Workgroups 3.11,
- MS Windows NT 3.5 or later, Windows 95 or
- OS/2 2.1x or later.

Hardware Installation

Important safety notice:
To avoid electric shock ensure that your computer is turned off and the AC power cord is removed from the mains socket before removing the top cover of your computer.

1. Remove the top cover of your computer. For more information, see your computer's manual.
2. If your system already has a SCSI interface or SCSI host adapter installed proceed from "Installing the CD-ROM drive" on page 6. If you are installing a third party SCSI adapter follow the instruction supplied with it. Otherwise proceed with the instructions for installing our (optional) interface card below.

(Optional) interface card

The optional interface card supplied with the drive kit is the AHA-1520A or AHA1520B from Adaptec, Milpitas, California, USA. The termination and jumper settings of this card have been pre-configured to operate in most ISA computers with the CD-ROM drive as the only device to be connected. In most cases you will not need to change these settings and the following instructions will be sufficient to install this card.

If, however, you need to connect additional devices to this card, or you have conflicts with other options installed in your computer you may need to change the termination or jumper settings. Please refer to the enclosed Installation guide from Adaptec for more detailed information. Then proceed as follows (refer also to figure 3).

4. Close the devices window and close control panel.
5. Restart the system to enable the changes made and configure the CD-ROM drive.

CD-ROM operation under Windows NT

1. Your CD-ROM drive will appear in File Manager, indicated by a CD icon. For data CDs click on the icon to display the disk contents.
2. Audio CDs can be played using Media Player which is installed in the Accessories folder.

Guide to operation
1. Power up your computer.
2. Press the eject button on the CD-ROM drive to open the loading tray.
3. Place the disk in the tray with the label side facing up.
4. Press the eject button or push the loading tray lightly in. The tray will be retracted automatically.
5. Wait for the busy LED to go out before trying to read the CD-ROM or play the CD. If you try to read or play the disc before the LED goes out an error will be displayed. Wait for the LED to go out and retry the operation.
6. In case of emergency such as power failure, you can eject the tray manually. Insert a straightened paper clip with a minimum straight length of 45 mm and diameter of 1 to 1.5 mm into the emergency eject hole and push in until the tray is slightly ejected. Remove the paper clip and open the tray fully by pulling out. After removing the CD push the tray back in fully to prevent damage. Normal operation will be restored once power is reapplied.

Maintenance and Care Instructions

CD-ROM drive
- Do not insert foreign objects into the tray.
- Do not try to manually force the tray open, other than explained above.
- When the drive is not in use keep the tray closed.
- Do not push down on the tray whilst it is open.

CD, CD-ROMs
Take care when handling CDs not to touch the surface, and keep free from dust and scratches. Do not expose to extremes of temperature and humidity. Never use bent or damaged CDs. If CDs become dirty, clean carefully with a soft cloth moistened with water and remove any remaining moisture with a soft dry cloth. Always wipe the disc from the centre out towards the edge. Never wipe circularly round the disc.
Troubleshooting Guide

Symptom: Tray fails to open
Check the following:
- Is the power connected?

Symptom: Tray fails to close
Check the following:
- Is the CD inserted correctly?

Symptom: Busy LED fails to light
Check the following:
- Is the CD inserted correctly?
- Is the power connected?

Symptom: System fails to start up
Check hard drive and CD-ROM drive jumper settings.
- Check SCSI cable connections (pin 1 to pin 1).
- Is the device driver disk still in the floppy drive?

Symptom: Device driver fails to load.
Check above.

Symptom: CDs or CD-ROMs cannot be read.
Check the following:
- Has the CD been placed correctly on the tray?
- Has the CD been placed with its label side up?
- The CD may be dirty, clean it.
- Is the CD scratched, warped or otherwise damaged?
- Has condensation formed on the disk or inside the drive?
- Are you using the software program for playing CDs or CD-ROMs correctly?

Symptom: CD-ROM is not installed in Windows
If Windows is automatically started at boot from the AUTOEXEC. BAT file, make sure that it is started after CORELCDX has been loaded.

Symptom: No sound or low sound level via sound card
Check the sound card installation according to the manufacturers instructions.
- Has the volume control been set to the correct level?

Symptom: No sound or low sound level via headphones
Only audio-CD sound is output via headphone socket.
- Has the volume control been set to the correct level?

Symptom: Not enough conventional memory after installation
Reduce the number of DOS buffers in CONFIG.SYS.
- Reinstall CorelSCSI and load drivers into upper memory (Refer also to your DOS manual).
- Run MEMMAKER (DOS 6.0) or other memory optimisation software.

Symptom: Choppy playback of large AVI files
Change the CDXCACHE read ahead size from 4 to 8, or disable CDXCACHE altogether (see README.TXT).
- Use SMARTDRV instead of CDXCACHE.

7. Do not allow any foreign object to get inside this equipment. Do not place small objects on or near this equipment.
8. Do not expose this equipment to direct sunlight for long periods of time or near radiators or other heat sources.
9. Do not operate this equipment in a dusty or humid environment, or where cigarette smoke is prevalent.

CD-ROM drive - Quick reference guide

Figure 1 Front view

Figure 2 Rear view

7. Do not allow any foreign object to get inside this equipment. Do not place small objects on or near this equipment.
8. Do not expose this equipment to direct sunlight for long periods of time or near radiators or other heat sources.
9. Do not operate this equipment in a dusty or humid environment, or where cigarette smoke is prevalent.
Important safety notices

For your safety please read the following instructions carefully:

1. When installing the CD-ROM drive it will be necessary to remove the top cover of your computer.
   To avoid electric shock ensure that your computer is turned off and the AC power is removed from the mains socket before installing this CD-ROM drive, (optional) interface card or any other peripheral equipment.

2. Class 1 laser product
   This equipment complies with European standard EN 60825 (or international Electrotechnical Commission [IEC] Publication 825).
   This equipment is classified as a class 1 LASER product and there is no hazardous LASER radiation with the safety protection specified by EN 60825.
   Caution: Use of controls or adjustment or performance of procedures other than those specified herein may result in hazardous radiation exposure.
   Do not remove the top cover of the equipment and never touch the internal parts in order to avoid exposure to invisible radiation.
   When the power switch is on, do not place your eyes close to the front panel, motorised tray or other openings to look inside the equipment.
   Laser specification
   Class 1 Laser product
   Wave length: 765 - 815nm
   Laser power: 0.19mW. No hazardous radiation is emitted with the safety protection specified by EN 60825

3. The labels affixed to the equipment are there to remind you of safety precautions. These labels must not be removed.
   The label shown below indicates the position of the laser in the equipment. This label must not be removed.

   CLASS 1 LASER PRODUCT
   According to EN 60825
   APPAREIL A LASER DE CLASSE 1
   per la loi EN 60825
   LASER KLASSE 1
   nach EN 60825

4. Radio frequency interference
   This equipment has been tested and found to comply with the limits for a Class B device, pursuant to EN 55022 (European Standard of Radio Frequency Emission for Information Technology Equipment).
   To reduce the risk of fire or shock hazard, do not expose this equipment to rain or water. Do not place containers of liquid on or near this equipment.
   When listening to audio CDs using headphones, do not turn the volume up too high. Your hearing may be impaired if your ears are exposed to very loud sounds.

Glossary

ASPI Manager   The ASPI Manager, usually supplied with your card is a software module that you install in your system. ASPI Managers are developed for specific SCSI interface cards and operating systems and provide a standard software interface for SCSI device drivers.

Device Driver   Refers to the software programs for enabling data communication between a personal computer and the SCSI peripherals.

Host adapter    The SCSI interface expansion board installed in the computer is often called a “host adapter”.

ISA             This is an acronym for “Industry Standard Architecture” and is used to describe the computer bus used in IBM PC AT and compatible computers.

SCSI ID         Each device (including the host adapter on a SCSI bus requires a unique SCSI ID. The SCSI ID is used to address each device attached to the computer.

SCSI interface  This is an acronym for “Small Computer System Interface” (pronounced “scuzzy”). It is a standard general purpose interface for connecting peripherals to a computer.

Terminator      The SCSI bus requires a terminator on the first and last devices on a SCSI chain to ensure that SCSI signals are transmitted without error.

Trademarks and copyrights

IBM and OS/2 V3 are trademarks of International Business Machines.

Photo CD™ is a trademark of Eastman Kodak Company.

Microsoft Windows 95 and Microsoft Windows NT are trademarks of Microsoft Corporation.

All other product names or trademarks are property of their respective owners.

CorelSCSI (DOS/Windows Version) Ver 2.1

This device driver software is developed by Corel Corporation. CorelSCSI! is a registered trademark and CorelSCSI software is the property of Corel Corporation and are protected by copyright. Any reproduction in whole or in part is strictly prohibited.

MS-DOS and Microsoft are registered trademarks of Microsoft Corporation.

MS Windows is a trademark of Microsoft Corporation. MSCDEX is a copyright of Microsoft Corporation.

All other product names or trademarks are property of their respective owners.
Introduction

This user guide gives you step by step instructions on how to install the CD-ROM drive, (optional) interface card, cables and driver software into your computer. We recommend that you read this user guide completely, paying special attention to the safety notices, before proceeding with the installation. Please keep this user in a safe place for future reference.

Contents

Important safety notices ...............................................................2
CD-ROM drive - Quick reference guide ........................................3
System requirements .......................................................................4
Hardware installation
  (Optional) interface card ..........................................................4
  Installing the CD-ROM drive ......................................................6
Software installation
  DOS Systems ..............................................................................8
  Windows Systems .....................................................................10
  OS/2 Systems .........................................................................13
  Windows 95 Systems ...............................................................14
  Windows NT Systems ..............................................................15
Guide to operation .......................................................................16
Maintenance and care instructions ...............................................16
Troubleshooting guide...............................................................17
Glossary .....................................................................................18
Trademarks and copyrights ..........................................................19

Note: References are made in the following text to “CR 504” (relevant to RS stock numbers 228-6600 and 228-6616).

If you are installing the following stock numbers, 268-1594 and 268-1601, please refer to “CR 508” instead.